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The Author
Kevin Siegel is a Certified Master Trainer (CMT), Certified Technical Trainer 
(CTT+), and Certified Online Training Professional (COTP). Following a successful 
tour of duty with the U.S. Coast Guard (where Kevin was twice decorated with the 
Coast Guard’s Achievement Medal), he has spent decades as a technical 
communicator, classroom and online trainer, eLearning developer, publisher, and 
public speaker. Kevin, who founded IconLogic, Inc., in the early 1990s, has written 
hundreds of training books for adult learners. Some of his best-selling books 
include “Adobe Captivate: The Essentials,” “Articulate Storyline: The Essentials,” and “TechSmith 
Camtasia: The Essentials.” Kevin has also been recognized by Adobe as one of the top trainers 
worldwide.

IconLogic
Founded in 1992, IconLogic is a training, development, and publishing company offering services 
to clients across the globe. 

As a training company, IconLogic has directly trained tens of thousands of professionals both on-
site and online on dozens of applications. Our training clients include some of the largest 
companies in the world including Adobe Systems, Inc., Urogen, Agilent, Sanofi Pasteur, Kelsey 
Seybold, FAA, Office Pro, Adventist Health Systems, AGA, AAA, Wells Fargo, VA.gov, American 
Express, Lockheed Martin, General Mills, Grange Insurance, Electric Boat, Michigan.gov, Freddie 
Mac, Fannie Mae, ADP, ADT, Federal Reserve Bank of Richmond, Walmart, Kroger, Duke 
Energy, USCG, USMC, Canadian Blood, PSA, Department of Homeland Security, and the 
Department of Defense.

As a development company, IconLogic has produced eLearning and technical documentation for 
Duke Energy, World Bank, Heineken, EverFi, Bank of America, Fresenius Kabi, Wells Fargo, 
Federal Express, Fannie Mae, American Express, Microsoft, Department of For-Hire Vehicles, 
DC Child and Family Services, DCORM, Canadian Blood, Cancer.org, MLB, Archrock, NEEF, 
CHUBB, Canadian Natural Resources, and Hagerty Insurance.

As a publishing company, IconLogic has published hundreds of critically acclaimed books and 
created technical documents for both print and digital publication. Some of our most popular titles 
over the years include books on HTML, Dreamweaver, QuarkXPress, PageMaker, InDesign, 
Word, Excel, Access, Publisher, RoboHelp, RoboDemo, iSpring, Presenter, Storyline, Captivate, 
and PowerPoint for eLearning.

You can learn more about IconLogic’s varied services at www.iconlogic.com.

http://www.iconlogic.com
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Book Conventions
Learners learn best by doing, not just by watching or listening. With that concept in mind, 
instructors and authors with years of experience training adult learners have created IconLogic 
books. Each of our books contain a minimal amount of text and are loaded with hands-on 
activities, screen captures, and challenge exercises to reinforce newly acquired skills.

This book is divided into modules. Because each module builds on lessons learned in a previous 
module, it is recommended that you complete each module in succession. 

Lesson Key
Instructions for you to follow look like this (the boxes are also used in bulleted lists):

 click this or do that

If you are expected to type anything or if something is important, it is set in bold type like this:

 type 9 into the text field

If you are expected to press a key on your keyboard, the instruction looks like this:

 press [shift]

Confidence Checks
As you move through the lessons in this book, you will come across the figure 
at the right. The figure indicates a Confidence Check. Throughout each 
module you will be guided through hands-on, step-by-step exercises. But at 
some point you’ll have to fend for yourself. That is where Confidence Checks 
come in. Please be sure to complete each of the challenges because some 
exercises build on completed Confidence Checks.
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System Requirements 
This book teaches you how to use many, but not all, of the features of iSpring Suite 10. The 
iSpring Suite software does not come with this book. The software can be purchased and 
downloaded directly from iSpring (www.ispringsolutions.com/ispring-suite).

Although you need to have both Microsoft PowerPoint and iSpring Suite 10 installed on your 
computer prior to starting the hands-on activities presented in this book, you do not need to 
purchase iSpring Suite to learn iSpring Suite. A free trial version of the software can be 
downloaded via iSpring’s website. The iSpring Suite trial has a few limitations, but it will work for a 
few weeks from the day you first start the program. Keep in mind that eLearning lessons that you 
create using the trial version of iSpring Suite will no longer open once the trial period expires. Any 
projects you create with the trial will be available to edit and publish once you license the 
software.

Here are the system requirements for installing and using iSpring Suite.

Hardware

Computer and processor Intel/AMD 1 GHz or faster

Memory 1024 MB RAM, 2 GB recommended

Free disk space 500 MB available disk space

Display Monitor resolution 1024x768 or higher

Video card NVIDIA® GeForce® 8 series, Intel® HD Graphics 2000, or 
AMD Radeon™ R600 or higher with 512 MB memory for regu-
lar video and 1 GB for HD video, Direct3D 10.1/Direct 2D com-
patible graphics adapter is required for the correct work of 
iSpring Cam Pro.

Audio Sound card and microphone (for narration recording)

Video Built-in or external webcam (for video recording)

Software

Operating System Microsoft® Windows® 7/8/10 (32- and 64-bit)

Microsoft PowerPoint Microsoft® PowerPoint® 2007/2010/2013/2016/2019/
Microsoft Office 365 subscription
(32- and 64-bit)

Microsoft Word Microsoft® PowerPoint® 2007/2010/2013/2016/2019/
Microsoft Office 365 subscription
(32- and 64-bit)

Browsers Microsoft Edge 81 and higher
Internet Explorer 11 and higher
Mozilla Firefox 74 and higher
Google Chrome 81 and higher

http://www.ispringsolutions.com/ispring-suite
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Data Files (iSpring Suite Project Assets)
You’re probably chomping at the bit, ready to dive into iSpring Suite, and begin creating 
eLearning lessons. Not so fast. Do you have sample projects to work with? What about graphics 
and videos? How about voiceover audio? No? No worries. I’ve got everything you need—I call 
them data files—and they can be downloaded from the IconLogic website for free. 

Download the iSpring Suite 10 Data Files
1. Download the student data files necessary to use with this book.

 start a web browser and go to the following web address: 
http://www.iconlogic.com/pc

 under the iSpring Suite Data Files section, click the 
iSpring Suite 10: The Essentials link

The download is a zipped file containing several folders and files. On some web browsers, 
a dialog box opens asking if you want to Save or Open the file. The image below shows 
the dialog box you will see if you use Firefox. I’ve elected to Save File.

2. Unzip the iSpring10Data files.

 locate the iSpring10Data.zip file you just downloaded to your computer

 unzip the file

Note: You can keep the iSpring10Data folder anywhere on your computer, but for 
ease of access, I suggest working from your desktop so that it’s easier to locate 
the project files as they are referenced during the guided activities in this book.

http://www.iconlogic.com/pc.htm
http://www.iconlogic.com/pc.htm
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How Software Updates Affect This Book
This book was written to teach you how to use iSpring Suite version 9 (you can check your 
version via the iSpring Suite 10 tab on the Ribbon, Help > About). At the time that this book was 
written, iSpring Suite 10.0.5 Build 15005 was the latest and greatest version of the software 
available from iSpring. 

With each major release of iSpring Suite, my intention is to write a new book to support that 
version and to make it available as soon as possible. Both Microsoft and iSpring frequently 
update their software to fix bugs and add functionality. Updated iSpring Suite versions could be 
called iSpring Suite 10.1.2 or 10.7.9 and so on. Usually minor updates have little or no impact on 
the lessons presented in this book. However, iSpring could make significant changes to the way 
the suite looks or behaves, even with minor updates. (Such was the case when Adobe updated its 
Adobe Captivate software from version 5 to 5.5—about a dozen features were added, and a few 
panels/pods were renamed, throwing readers of my books into a tizzy.)

Because it is not possible for me to recall or update existing printed books, instructions you are 
asked to follow in this book may not exactly match the patched/updated version of the software 
that you are using. If something on your screen does not match what is in the book, please visit 
the book errata page on my website (http://www.iconlogic.com/skills-drills-workbooks/errata-
pages.html). If an iSpring software update has altered something that impacts the lessons in this 
book, I will address the issues on that page as they are brought to my attention.

Contacting IconLogic
Web: www.iconlogic.com
Email: ksiegel@iconlogic.com
Phone: 410.956.4949, ext 711

http://www.iconlogic.com/skills-drills-workbooks/errata-pages.html
http://www.iconlogic.com
mailto:info@iconlogic.com
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Rank Your Skills
Before starting this book, complete the skills assessment on the next 
page.



How This Assessment Works
Ten course objectives for iSpring Suite 10: The Essentials are listed below. Before starting the book,
review each objective and rank your skills using the scale next to each objective. A rank of  means No
Confidence in the skill. A rank of  means Total Confidence. After you’ve completed this assessment,
work through the entire book. After finishing the book, review each objective and rank your skills now that
you’ve completed the book. Most people see dramatic improvements in the second assessment after
completing the lessons in this book. 

Before-Class Skills Assessment
1. I can sync animations with voiceover.     

2. I can use iSpring to edit an audio clip.     

3. I can add a Dialog Simulation to a presentation.     

4. I can add Characters to a slide.     

5. I can add an interaction.     

6. I can add a quiz to a project.     

7. I know how to publish as HTML5.     

8. I know what SCORM stands for.     

9. I can publish an Accessible iSpring project.     

10. I can create a screen recording.     

After-Class Skills Assessment
1. I can sync animations with voiceover.     

2. I can use iSpring to edit an audio clip.     

3. I can add a Dialog Simulation to a presentation.     

4. I can add Characters to a slide.     

5. I can add an interaction.     

6. I can add a quiz to a project.     

7. I know how to publish as HTML5.     

8. I know what SCORM stands for.     

9. I can publish an Accessible iSpring project.     

10. I can create a screen recording.     

IconLogic, Inc.
www.iconlogic.com

Skills Assessment
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iSpring Suite’s Role in eLearning
It’s likely that you’ve used Microsoft PowerPoint at least a few times. As far as I’m concerned, 
PowerPoint is an awesome program, and you can easily create visually stunning presentations 
with the tool. Unfortunately, the vast majority of the presentations created with PowerPoint are not 
very good. I’m betting that you have seen your fair share of presentations containing too many 
slides packed with as much text and clipart as possible. There’s often an obnoxious use of colors 
and fonts. The layouts are predictable and boring. Most of the slides have a main headline, a 
subhead, a bulleted list, clipart images, and copious amounts of animation (the bullets fly here, 
there, everywhere. There’s a name for those kinds of presentations: Death by PowerPoint. 

When learners are threatened with Death by PowerPoint, most will either avoid the presentation 
or quickly click from one slide to the next to end the misery as soon as possible. There’s typically 
little interaction in those deadly presentations beyond clicking forward and back buttons. 

Given how PowerPoint gets most of the blame when someone presents a Death by PowerPoint, 
it’s easy to be a PowerPoint hater. However, I am not a hater. I happen to think that in the hands 
of a creative person, PowerPoint can be used to develop great presentations. While I love 
PowerPoint, it cannot be used to create compelling, engaging eLearning—asynchronous training 
content is available online, 24-hours per day, 7 days per week.

Why can’t you create awesome eLearning with PowerPoint? First, PowerPoint does not feature 
the kind of interactive tools necessary to engage learners. I know, you can animate anything and 
everything, and you can add interactive buttons to a PowerPoint slide. But animations and/or 
forward and back buttons do not constitute a high level of learner engagement. In most 
PowerPoint presentations, there’s little to no opportunity to gauge learner comprehension of the 
content because most versions of PowerPoint do not include scoreable quizzes. Recent updates 
to PowerPoint do finally allow you to add quizzes via Forms, but the feature is limited.

When the time comes to deliver content created in PowerPoint to learners across the globe, 
there’s no HTML5 output to allow for seamless viewing over a web browser. Learners either need 
to have PowerPoint installed on their computers or download the PowerPoint player from 
Microsoft. And although you can upload a PowerPoint presentation into a Learning Management 
System (LMS) as a course asset, there is no way to make the presentation SCORM or AICC-
compliant so that learner progress can be tracked by the LMS or administrators.

So what do you do when the boss tells you to use PowerPoint to create the company’s flagship 
eLearning course? You get yourself an eLearning development tool, and that’s where the iSpring 
Suite comes in. The suite is a collection of awesome tools that work with PowerPoint to help you 
create killer eLearning courses. 

After installing the iSpring Suite on your computer and then starting PowerPoint, you’ll find that 
there’s a new tab on the PowerPoint Ribbon: iSpring Suite. The image below shows the iSpring 
Suite 10 tab, along with its specific set of eLearning tools.

At the far left of the iSpring Suite 10 tab, you’ll find recording tools for both audio and video. As 
you move right, you’ll see tools for adding interactions, characters, and more. You’ll be using most 
of the tools on the tab, along with the standard PowerPoint tools, as you move through the guided 
activities in this book.
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Designing Slides Within PowerPoint
As mentioned earlier, working with iSpring Suite means you also need to work within PowerPoint. 
It stands to reason that the better your PowerPoint presentation looks, the more likely it is that 
your learners will want to consume the content you publish.

I saw a guy the other day wearing a t-shirt that read, “Guns don’t kill people, people kill people.” 
Often the same holds true for PowerPoint presentations. “PowerPoint doesn’t kill presentations; 
people kill presentations.”

It’s easy to point the finger at PowerPoint for making office meetings unsuccessful and 
presentations a snore, but the truth is that poor design is really to blame.

The good news is that you don’t have to be a seasoned designer to produce beautiful and 
effective PowerPoint presentations. Here are a few tips to get you started:

 There are certainly occasions when a bullet really is the most successful way to 
convey an idea. However, just because PowerPoint defaults to using a bulleted format 
doesn’t mean that you should go with the flow and present all your information with a 
bullet in front of it. 

 Try splitting the bullets up into separate slides with a single image to illustrate each 
point, or forgo the text altogether and replace it with a chart, diagram, or other 
informative image.

 It is not necessary to have every bit of information you cover on the slide. Encourage 
your audience to listen and, if necessary, take notes based on what you say, not what 
is displayed on the slide. 

 Nothing says “High School Presentation Circa 1997” quite like a dancing animated 
image clumsily plopped on a rainbow gradient background with a big, garish WordArt 
title (complete with myriad animation effects).

 Keep in mind that PowerPoint presentations are plentiful—particularly bad ones. Trust 
us, your learner will not be impressed with how many moving, colorful parts each slide 
contains. 

 Consider using photographs on your slides instead of clipart. PowerPoint comes 
preloaded with photographs you can use. And there is an extensive set of 
backgrounds, images, and icons that come with iSpring Suite. 

If you find the selection isn’t enough to suit your needs, try looking online for stock 
photos. There are many free sites, but keep in mind that to save time and frustration 
(and improve on the selection and quality), you might want to set aside a budget to pay 
for the photographs.
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Fonts and Learning
There is no denying that the most important thing about eLearning is solid content. But could you 
be inadvertently making your content harder to read and understand by using the wrong fonts? Is 
good font selection really important? Read on to discover the many surprising ways fonts can 
affect your content.

Some Fonts Read Better On-Screen
eCommerce Consultant Dr. Ralph F. Wilson did a study in 2001 to determine if serif fonts (fonts 
with little lines on the tops and bottoms of characters, such as Times New Roman) or sans serif 
fonts (those without lines, such as Arial) were more suited to being read on computer monitors. 
His study concluded that although Times New Roman is easily read in printed materials, the lower 
resolution of monitors (72 dpi vs 180 dpi or higher) makes it much more difficult to read in digital 
format. Arial 12 pt was pitted against Times New Roman 12 pt with respondents finding the sans 
serif Arial font more readable at a rate of 2-to-1.

Wilson also tested the readability of Arial vs. Verdana on computer screens and found that in font 
sizes greater than 10 pt, Arial was more readable, whereas Verdana was more readable in font 
sizes 10 pt and smaller.

So should you stop using Times New Roman in your eLearning lessons? Not completely. For 
instance, you can still use Times New Roman for text content that is not expected to be skimmed.

Some Fonts Increase Trust
A study by Sharath Sasidharan and Ganga Dhanesh for the Association of Information Systems 
found that typography can affect trust in eCommerce. The study found that to instill trust in online 
consumers, you should keep it simple: “To the extent possible, particularly for websites that need 
to engage in financial transactions or collect personal information from their users, the dominant 
typeface used to present text material should be a serif or sans serif font such as Times New 
Roman or Arial.”

If you feel your eLearning content will be presented to a skeptical audience (or one you’ve never 
worked with before), dazzling them with fancy fonts may not be the way to go. I’m not saying that 
you shouldn’t use fancy fonts from time to time to break up the monotony of a dry lesson, but 
consider using such nonstandard fonts sparingly. Use the fancy fonts for headings or as accents 
but not for the bulk of your text.

The Readability of Fonts Affects Participation
A study done at the University of Michigan in 2008 on typecase in instructions found that the 
ease with which a font in instructional material is read can have an impact on the perceived skill 
level needed to complete a task.
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The study found that if directions are presented in a font that is deemed more difficult to read, “the 
task will be viewed as being difficult, taking a long time to complete and perhaps, not even worth 
trying.”

Based upon the aforementioned study by Wilson, it is probably not a good idea to present 
eLearning material, especially to beginners, in a Times New Roman font, as it may make the 
information seem too difficult to process or overwhelming.

Most Popular Fonts
I polled my customers and former students and asked which fonts they tended to use in 
eLearning. Here is a list of the most popular fonts:

 Verdana

 Helvetica

 Arial

 Calibri

 Times

 Palatino

 Times New Roman

 Century Schoolbook (for print)
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Fonts and Personas
If you are creating eLearning for business professionals, you might want to use a different font in 
your design than you would if you were creating eLearning for high school students. But what font 
would you use if you wanted to convey a feeling of happiness? Formality? Cuddliness?

In a Microsoft-funded study by A. Dawn Shaikh, Barbara S. Chaparro, and Doug Fox, the 
perceived personality traits of fonts were categorized. The table below shows the top three fonts 
for each personality objective.

Source: http://usabilitynews.org/perception-of-fonts-perceived-personality-traits-and-uses/
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Planning eLearning Projects
By the time you finish the last lesson in this book, you should be able to use the Suite to create 
some compelling, technically sound eLearning lessons. However, just because you will soon be 
able to publish technically sound content does not necessarily mean you will go out and create 
good eLearning. If you want to create good, useful lessons, you have to plan ahead. Before 
creating an eLearning lesson using iSpring Suite, ask yourself the following questions:

 Who is my audience? Are you training children or business professionals? The images 
you use and the interactions you create will need to take your specific audience into 
consideration.

 How is my eLearning content relevant to my learner? Will my content motivate my 
learners? Is there an appropriate amount of context?

 Is my content expected to bring about change? If yes, what specific change(s)? How 
do I plan to track that change?

 Do I want my lessons to contain images and background music? If so, where will I get 
those assets? While iSpring Suite comes with assets if you have a subscription, those 
assets may not be enough. In that case, you’ll need a reliable source for gathering 
additional assets. For instance, I use pay services such as www.BigStock.com for 
many of the images I use in my eLearning lessons. I also rely heavily on eLearning 
resources, such as www.eLearningBrothers.com for assets appropriate for eLearning.

 Do you need to capture learner data such as quizzes? If so, you’ll likely need an LMS. 
You’ll learn more about LMSs beginning on page 120.

When planning projects, keep in mind that the most useful lessons contain the following basic 
elements:

 Title slide (telling the learner what they are going to learn)

 Lesson slides containing narration, music, and other sound effects

 Images and animations

 As much interactivity as possible (via interactions and buttons)

 A quiz (to gauge the effectiveness of the lesson)

 An ending slide (reviewing what the learner learned)

Above all, remember the mantra used in the best training courses world-wide: tell them what 
you’re going to teach them, teach them, and then tell them what you taught them. If your 
eLearning content created with iSpring Suite takes this mantra into account, there’s a very good 
chance you’ll not just create eLearning content, you’ll create successful eLearning content.

http://www.bigstockphoto.com
http://www.bigstockphoto.com
http://www.bigstockphoto.com
http://www.bigstockphoto.com
http://www.bigstockphoto.com
http://www.bigstockphoto.com
http://www.eLearningBrothers.com


iSpring Suite10: The Essentials

8 © 2021, IconLogic, Inc. All Rights Reserved.

eLearning Budgeting Considerations
Many new eLearning developers underestimate the time needed to produce eLearning content 
with PowerPoint and iSpring Suite. The following table should help.

What Production Does Not Include
I bet you’re wondering what “production” means, especially considering that most of the projects 
you create will likely be in the medium or large categories (21-70 slides) and take you, on 
average, up to 10-hours to produce.

To begin, let’s consider what “production” does not include. An effective 1-hour eLearning course 
will not play for 60 consecutive minutes. Given today’s distractions, the perfect playtime for any 
one eLearning lesson is between 3 and 7 minutes (a 5-minute playtime is ideal). A 5-minute 
playtime means that a 60-minute eLearning course would consist of 12, 5-minute lessons. 

Before you can even think about creating an eLearning course, you’ll need a script and/or 
storyboard (see page 10). A general rule of thumb is that it takes up to 40 hours to write every 1 
hour of eLearning. Depending on how fast you write, you could easily save some time here (if 
you’re a fast writer). However, you could also double those hours if you’re new to creating 
eLearning content (or perhaps you simply write slowly).

If you’re going to include voiceover audio (see page 38), you’ll first need to write a voiceover 
script. Many writers budget at least 50 percent of the time it takes to write a standard script to 
write a voiceover script. And some writers say that writing a voiceover script is just as difficult as, 
if not more difficult than, writing a step-by-step eLearning script. To be safe, you should budget 
the same number of hours to write a voiceover script as you budget for the eLearning script.

Production won’t include creating a PowerPoint template, a completed shell project that you will 
use as the basis of all of your projects. It’s not difficult to create a template, but it will take time. An 
ideal template contains placeholders, an introduction slide, transitional slides, a conclusion slide, 
and a quiz placeholder. I typically budget up to 10 hours to create a project template.

What Production Does Include
A single interactive PowerPoint/iSpring Suite eLearning lesson could take several hours to 
produce. What’s part of the production process? 

You’ll spend a lot of time working with every PowerPoint slide. Adding the content and the images 
will take time. Beyond the slide content and images, you’ll be adding interactive objects. You’ll 
also likely be adding audio to the presentation (if you’re lucky, the audio won’t need any editing, 
but it’s likely you’ll need to spend time editing the audio). 

To measure the success of your eLearning lesson, you’ll need a quiz. It’s going to take time to 
write the questions, the answers, and the distractors. If you’ve never written questions and 
answers for a quiz, it’s not as easy as you think. And it’s going to take time. You should budget 
15-20 minutes per question (and keep in mind that the average eLearning lesson should contain 
no more than one question for each minute of eLearning playtime).

Project Size Number of Production Hours
Small Projects (1-20 slides) 1-4 hours
Medium Projects (21-40 slides) 5-7 hours
Large Projects (41-70 slides) 8-10 hours
Bloated Projects (more than 71- slides) Consider splitting lessons this large into 

smaller presentations.
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During the production process, you’ll be previewing your project... a lot. That takes time (you 
cannot do any work in iSpring as the preview is created).

When your work is done, you’ll publish the project and possibly upload the published assets files 
to a web server or LMS. You will be testing the lessons for scoring or interactivity errors. After 
that, you’ll need to fix problems you run across (and there will likely be plenty of problems that 
need to be fixed). After fixing those problems, you’ll need to republish, repost, and retest.

Add it all up, and your budget looks something like this (keep in mind that the timing below does 
not include the time it will take to record and edit your own voiceover audio):

 40-80 hours to write an eLearning script or create the storyboard to support 12, 5-
minute lessons for a 1-hour course.

 120 hours to edit, produce and test 12, 5-minute lessons for a 1-hour eLearning 
course.

 40-80 hours to write a narration script to be used by your narrator.
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Scripts for Software Demonstrations
When developing eLearning for software demonstrations or simulations (using eLearning tools 
like Adobe Captivate), it’s a great idea to begin with a script—a detailed list of step-by-step 
instructions. When I have created text-based eLearning scripts, or received them from clients, I’ve 
generally seen them in two flavors: paragraphs and tables.

Scripts in Paragraph Format: If you are creating a script for eLearning, your text should be 
formatted in a way that is easy to follow. You can format the script in paragraphs, but you will 
need to clearly label the parts. You may find that formatted paragraphs are all you need. 
However, I recommend a table or grid format for a script that will be developed into eLearning.

 Step Number

 Screen: Display the document

 Action: Move the cursor to the Format menu and click Format

 Caption: Click Format

 Voiceover: Now let’s open the Format menu to get started with formatting the 
document.

Scripts in Table Format: Below is a picture of a sample script used to create an Adobe Captivate 
eLearning lesson. The script was created in Microsoft Word. You’ll find the script among the 
assets within the iSpring10Data folder (the file is called SampleScript).
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Storyboarding
When the training objective is a soft skill, such as how to interact with others in the workplace or 
how to comply with legally required behavior, there may be no step-by-step process to spell out. 
Instead, you have to describe and demonstrate the behavior in a way that engages the learner. 
This is where the screen writing part of writing training materials comes into play. 

You can present soft skills, which is typically what iSpring Suite is used to create, through slides 
or videos. Either way, the material must be both clear and engaging. 

Here is a typical plotline for soft skills training.

 Statement of a real-world problem, challenge, or requirement

 Illustration of what happens on failure

 Demonstration and description of how to succeed

 Confidence check or evaluation

A visual storyboard allows you to plan what is pictured or acted out as well as what is said for 
each slide or scene. Even if you are not an artist, you can sketch the basics of the characters, 
setting, and behavior for each scene. In fact, take a look at the image below. I think that you will 
agree that the image is not a work of art. Nevertheless, you can tell that it depicts two people 
meeting in the reception area of an office. Even if the images mean something entirely different to 
you, you will be writing the script for these images in the Confidence Check that follows.
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Storyboard Confidence Check
Here are the visual storyboards for a training unit on how to greet a visitor to 
your office. Write the script for these scenes. Include a voiceover for each 
scene, briefly describe the action, and create dialog for the two actors in each 
scene as well. Some screens will have voiceover only.

Objective:

At the end of this lesson, you will be able to list at least four key behaviors in 
welcoming a guest to your office. In addition, you will have developed a 
specific plan for how to do this in your own office setting.
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Suggested Answers
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The Value of Audio
You’ll learn how to record, import, and edit audio files beginning on page 41. Research has shown 
that voiceover audio, even if it isn’t highly produced, enhances the learning experience when 
compared to eLearning lessons with no audio. If your budget allows, the ideal way to approach 
audio is to write a voiceover script and then send the script to a voiceover professional. The cost 
to work with a professional can vary from state to state and region to region. I’ve seen audio cost 
as little as a few pennies per word, to several dollars per word. Still other voiceover professionals 
don’t charge by the word at all, they charge by the page.

If you prefer to record the audio yourself, you do not need to have any prior experience recording 
audio. Nor do you need to have a deep, radio-personality voice. In fact, regular everyday people 
record perfectly wonderful audio every day. And you’ll soon discover that recording audio (or 
importing audio files) from within iSpring Suite is very easy. All you really need to record audio is 
a microphone either hooked up to your computer or built-in. (While some built-in microphones 
record audio very well, you’ll almost always get better results if you use an external microphone or 
headset.)

Should Voiceover Audio Match the Screen Text?
I spoke to a learner who relayed a frustrating experience she had with an eLearning course. She 
needed information about coding web pages using HTML5. She accessed a training site and 
played an eLearning demo that explained how to redefine an HTML tag. During the video, the 
learner found herself both listening to the voiceover audio and reading the text on the screen. She 
quickly realized that the slide text was identical to the voiceover audio. At about the same time, 
because she had been trying to figure out whether the voiceover really was the same as the slide 
text, she realized that she had not absorbed some of the content. She also noticed that she could 
read the text on the screen faster than the narrator, so she turned off the audio and just read the 
rest of the slide text.

In the end, the learner told us that the decision to turn off the audio was a mistake. She felt that 
she would have had a better learning experience if she had listened to the audio while focusing on 
the videos and ignoring the printed captions at the bottom of the screen.

The learner experienced first-hand what I have heard from others: screen text that is identical to 
the voiceover narration can be a distraction rather than an added value to the learning process. 
Ideally your slides will have graphics, animation, or video accompanied by voiceover—with little or 
no text on the screen at all. Because learners are trying to pay attention to the visuals, the need to 
move their eyes to focus on the accompanying screen text can be difficult. Having a voiceover 
explain the visuals enables the learner to absorb the audio and visual information at the same 
time.

Does that mean your PowerPoint slides should never include text or bulleted lists? Of course not. 
Sometimes screen text is required simply because there is no voiceover or the learner may not 
have access to the voiceover. 

Other times when text should appear on screen are:

 When there is no visual graphic and the caption text is the only information being 
presented

 When the text is closely integrated with the graphics—as labels rather than separate 
descriptions

 When the information being covered is complex and benefits from both audio and 
visual presentation, as with math equations or chemical formulas

 When the information may be needed over time, as in instructions for a learning 
exercise where the learner may need to repeatedly refer to the instructions
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Module 1: Getting Started with 
iSpring Suite
In This Module You Will Learn About:

• The iSpring Suite 10 Interface, page 18

• Characters, page 25

• Backgrounds and Templates, page 32

And You Will Learn To:
• Explore an Existing Project, page 19

• Publish Output to Your Computer, page 23

• Insert and Resize a Character, page 25

• Insert a Background, page 32

• Insert Template Slides, page 35
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The iSpring Suite 10 Interface
As mentioned in the Preface (page 2), iSpring Suite is an eLearning development companion for 
Microsoft PowerPoint. You access the tools that comprise the iSpring Suite two ways: via the 
iSpring Suite 10 tab on the PowerPoint Ribbon or start iSpring Suite’s Quick Start via the 
Windows Start menu (shown below). 

Courses: Creates a blank PowerPoint presentation. You’ll create a course from scratch 
beginning on page 32.

Quizzes: Adds an interactive quiz to a PowerPoint presentation that can be set up to report 
scores to a Learning Management Systems (LMS). You’ll learn about quizzes beginning on 
page 98.

Simulations: Creates branching scenarios/dialog simulations. You’ll learn about this feature 
beginning on page 82.

Screencasts: Creates software video demonstrations including some nifty annotations. You’ll 
learn about this feature beginning on page 91.

Interactions: Adds interactive objects to PowerPoint slides. You’ll learn about interactions 
beginning on beginning page 76.

Books: Creates a slick-looking book from a PowerPoint presentation, Word document, or PDF. 
You’ll publish a book during a Confidence Check on page 126.

iSpring Space: A web-based platform for authoring collaboration and review.

During the first few guided activities in this book, you’ll open an existing presentation created 
collaboratively with PowerPoint and iSpring Suite. You’ll then have an opportunity to get 
comfortable with some of the tools unique to the iSpring Suite 10 tab on the PowerPoint Ribbon.

Note: Before moving forward, ensure that you have downloaded and installed the 
iSpring10Data assets as directed in the About This Book section of this book 
(page viii).
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Guided Activity 1: Explore an Existing Project
1. Using Microsoft PowerPoint, open the AquoSafetyDemo.pptx presentation from the 

iSpring10Data folder.

The AquoSafetyDemo presentation was created using standard features found in 
PowerPoint combined with iSpring Suite’s tools. At first glance, the presentation looks like 
any other PowerPoint presentation. As mentioned in the Preface of this book, iSpring 
Suite’s relationship within PowerPoint seems subtle, as the only apparent change to the 
PowerPoint interface is the addition of the iSpring Suite 10 tab on the Ribbon (shown 
highlighted below).

2. Use the iSpring Suite 10 tab on the Ribbon to preview the eLearning lesson.

 on the PowerPoint Ribbon, select the iSpring Suite 10 tab

 on the iSpring Suite 10 tab, click the Preview drop-down menu and choose Preview 
Entire Presentation

p

Generally speaking, when you click the 
bottom half of a tool within PowerPoint, you’ll 
see menu items. If you click the top part of the 
tool, the most common item within the menu is 
selected for you.
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A preview of the presentation appears that looks and behaves much as it would if you 
published the lesson.

The presentation contains images, videos, audio, and a quiz. You will learn how to work 
with these kinds of features as you work through the lessons in this book.

Note: If there are iSpring components in a PowerPoint presentation, such as an 
iSpring quiz or an interaction, they will not appear in the presentation if iSpring 
Suite is not installed on the computer. When it comes to previewing, iSpring 
components will not preview in a standard PowerPoint Slide Show. You can only 
preview iSpring components when the presentation is previewed using iSpring 
(via the iSpring Suite 10 tab on the Ribbon > Preview.)

3. Spend a few moments going through the presentation.

At the top of the window, notice that there are five icons. If you click each of the icons, you 
will see what a user might see if using a computer, tablet, or phone.

4. When finished previewing the project, close the preview window.
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5. Explore the iSpring Suite tool groups.

 at the far left of the iSpring Suite 10 tab, observe the Narration group of tools

You’ll use the tools in the Narration group to record, import, edit, and sync audio. 
You’ll work with audio beginning on page 38.

 just to the right of the Narration group, observe the Insert group

The Insert group gives you access to quizzes, interactions, screen recordings, and more. 
When it comes to adding some awesome interactive components to your project, this is 
the place to look.

 still working on the iSpring Suite 10 tab, notice the Content Library group

As you build your projects, you’ll come to appreciate the Content Library where you find a 
collection of templates, icons, and characters that you can use on your slide. Access to 
these assets is included with the iSpring Suite subscription (www.ispringsolutions.com/
ispring-suite).

 on the iSpring Suite 10 tab, notice the Presentation group

The Presentation group lets you control how each of the slides in the presentation 
behaves. Do you want them to be clickable? Do you want them to move forward by 
themselves? How about building a branching scenario? You’ll control all of the options via 
Slide Properties. If there are resources you’d like to add to your presentation or you’d like 
to include your corporate logo, you’ll find the options available in the Presentation 
Resources. And the Player allows you to include an Outline, Notes, and more.

https://www.ispringsolutions.com/ispring-suite
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 on the iSpring Suite 10 tab, notice the Publish group

There are two options in the Publish group: Preview and Publish. You’ve already used the 
Preview icon to see how your eLearning content will look if you publish it. The Publish 
feature is something you’ll use if your project is finished and you’re ready to make it 
available for your learners.

 on the iSpring Suite 10 tab, notice the About group

The Options icon allows you to set up your microphone and webcam. Updates helps to 
ensure that you’re running the latest and greatest version of iSpring Suite. Help gives you 
access to, among other things, a wonderful Community of like-minded eLearning 
developers and professionals who answer iSpring Suite questions. The Help menu’s 
About option lets you know which version of iSpring Suite you’re currently using and 
provides information about the license. And if you have an account to iSpring Space, you 
can login via the Log in area.
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Guided Activity 2: Publish Output to Your Computer
1. Ensure that the AquoSafetyDemo.pptx presentation is still open.

2. Open the Publish dialog box.

 from the Publish group on the iSpring Suite 10 tab, click 
Publish

The Publish dialog box opens. This is the dialog box you will use 
once you have finished creating your eLearning lesson using 
iSpring Suite. To create eLearning content, you need both Microsoft PowerPoint and 
iSpring Suite. Before learners can use your output, you need to publish the presentation 
and then upload it to a web server, to iSpring Space, iSpring Learn, or to a LMS. 

3. Review the options when publishing locally.

 from the categories at the left of the Publish dialog box, click My Computer

You can Output your project as HTML5 or as a Video. If you publish your content as 
HTML5 and upload the output files to a server, it remains interactive when accessed by 
learners. If you publish as a video, interactivity that you’ve added to the presentation 
(such as a quiz) won’t work.

4. Publish output to your computer.

 from the categories at the left of the Publish dialog box, click My Computer

 at the right of the Folder area, click Browse

 open the PublishProjectsHere folder

 click the Select Folder button

 from the Output Options area, ensure HTML5 is selected

 click the Publish button
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The Publishing is complete dialog box appears. And just like that, you’re a published 
eLearning author. Congratulations!

 click the View Course button

The output opens in your default web browser.

5. Close the browser window.

6. Return to PowerPoint and close the Publishing is complete screen.

7. Close the AquoSafetyDemo presentation. There is no need to save the presentation if you 
are prompted.
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Characters
Finding quality, royalty-free photographs is always a challenge, especially if you’re looking for 
people that you can use throughout your iSpring Suite projects as guides. Fortunately, iSpring 
Suite comes with a wonderful assortment of Characters that are free to use in your iSpring 
projects.

Guided Activity 3: Insert and Resize a Character
1. Using Microsoft PowerPoint, open CharacterMe from the iSpring10Data folder.

2. Insert a Character onto slide 2.

 go to slide 2

 on the Ribbon, click the iSpring Suite 10 tab

 from the Content Library group, click Characters

The Characters — iSpring Content Library window opens.

 in the Search box, type Samantha and press [enter]

The image catalog is filtered to show only those images labeled Samantha.

 select the second version of Samantha

Note: In the first image above, notice that there is a padlock next to the character 
indicating that only one pose will be available for use. The full suite license to 
iSpring Suite Max is required to access all the Content Library assets. In the 
second image, I’m logged into iSpring Suite Max so the padlock is removed.
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Several poses appear.

 select any pose that you think looks welcoming (if you’re using the trial version of 
iSpring suite, only the first pose is unlocked and available for use)

 click the Insert button

The selected Character appears in the middle of the slide. 

3. Resize an image.

 on slide 2, right-click Samantha and choose Size and Position

The Format Picture panel appears at the right of the PowerPoint window.

 change the Scale height to 30 and then press [enter]

Notice that because Lock aspect ratio is selected by default, the Scale width of the 
image automatically changes to 30.
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4. Reposition the image.

 drag Samantha to the left side of the slide until your slide is similar to the image below

Characters Confidence Check
1. Go to slide 3 and add another version of the Samantha character.

2. Resize and position the character at the left of the slide, similar to the 
positioning shown below.

3. Go to slide 6 and add a picture of Samantha facing left.

4. Position the new character between the word me and the word myself.

5. Still working on slide 6, copy and paste the left-facing character to get a second copy.

6. Position the copied character directly on top of the original.
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7. On the Picture Format tab of the PowerPoint Ribbon, click the Rotate drop-down menu 
and choose Flip Horizontal.

8. Position the two characters next to each other similar to the image below.

9. Select the Home tab on the Ribbon and, from the Editing group, click the Select drop-
down menu and choose Selection Pane.

You will soon add animations to slide objects. Naming the objects first makes it easier to 
animate them later.
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10. Select the first image and, on the Selection Pane, change the name of the image to 
imageLeft.

11. Change the name of the second image to imageRight.

12. Change the name of the text box containing the word Me to Me.

13. Change the name of the text box containing the word Myself to Myself.

Next, you’ll animate slide objects.

14. On the Selection pane, select both imageLeft and Me. (You can select noncontiguous 
objects by pressing [ctrl] and clicking the objects on the Selection pane.)

15. Select the Animations tab on the Ribbon and select the Fade animation.

The selected objects now fade onto the slide. That’ll be a nice effect but what will make it 
even better is to have both images fade out and then have the other two objects fade in. 
You’ll take care of that next.
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16. With both objects still selected, Select the Animations tab on the Ribbon and select 
Add Animation.

17. From the Exit animations, choose Fade.

18. Using the Selection pane, select both imageRight and Myself. 

19. Apply the Fade animation to both selected objects.

20. On the Animations tab, select Animation Pane.
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The Animation Pane allows you to see and manage the animations on a selected slide. 
For instance, you can drag or stretch any of the squares next to each animation to either 
extend that animation’s playtime or delay when the animation occurs.

21. On the slide, position the two Samantha images on top of each other similar to what is 
shown below.

22. From the iSpring Suite 10 tab on the Ribbon, Preview the selected slide.

Each time you click the slide, you’ll see the fade-in and fade-out animations. After you 
learn about audio during the next module, you’ll be able to synchronize animations like 
these with audio.

23. Save and close the PowerPoint presentation.
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Backgrounds and Templates
You’ll find iSpring’s Backgrounds and Templates helpful as you kick-start your project. 
Backgrounds allow you to take any blank slide and enhance it with supplied background images. 
Templates let you add one or multiple slides to a project that, in addition to containing an 
assortment of theme-related background images, include helpful text placeholders that suggest 
content that you might want to incorporate.

Guided Activity 4: Insert a Background
1. Insert a Hospital Background onto a slide.

 ensure that PowerPoint is open

 create a new, blank PowerPoint presentation

 select the iSpring Suite 10 tab on the Ribbon

 from the Content Library group, click Backgrounds

The Backgrounds—iSpring Content Library window opens.

 from the list at the left, select Hospitals

 select any of the background images

 click the  Insert button
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The selected image is added to the presentation and automatically sized to fit perfectly on 
the slide.
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Backgrounds Confidence Check
1. Insert a Character from the Medicine category onto the background. 

(You learned about Characters on page 25.)

2. Resize and reposition the Character as appropriate to work best with 
the Background image.

3. Insert a few blank slides into the presentation and then spend a few moments adding 
backgrounds and characters as appropriate.

4. When finished, save the presentation to the iSpring10Data folder as MyScene. Leave the 
project open for the next activity.
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Guided Activity 5: Insert Template Slides
1. Ensure that the MyScene presentation you created during the last activity is still open.

2. Insert Template slides.

 select slide 1

 from the iSpring tab on the Ribbon, Content Library group, click Slide Templates

The Slide Templates—iSpring Content Library window opens.

 from the Slide type list at the left, select Opening

 from the middle of the Slide Templates dialog box, scroll down to the 
Hospital Scenario category

 select all three slides in the Hospital Scenario group

 click the Insert button

Three slides are added to your presentation.
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Templates Confidence Check
1. Using the PowerPoint Filmstrip, drag the three new slides to the top of 

the other presentation slides.

2. On slide 1, edit the placeholder text as shown below.

3. On slide 2, edit the 
placeholder text as 
shown at the right.

4. Spend a few 
moments adding 
some Content slide 
types from the 
Hospital Scenario 
templates.

5. Save and close the 
presentation. 
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